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1 CHANGES IN THIS VERSION 
 

 

 

- Updated for Live 10 compatibility.  This version of DDC requires Live 10.0.0 or later.  DDC v1.0.4 supports Live 

9.6 and later.  And DDC v1.0.3 supports older versions of Live 9, but is no longer supported.  All three DDC 

versions are available from account on our online shop. 

 

- Added handling for new Live 10 devices. 

 

 

 

 

 

 

UPDATE NOTE:  If you’re updating from a previous version of DDC, installing the new version of DDC will overwrite 

settings that you’ve transferred to Live.  To re-transfer your settings, simply open the editor, select the script for which you 

want to transfer settings and select Save and Transfer from the File menu. 
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2 GENERAL OVERVIEW 
DDC (short for Dedicated Device Control) provides a new means of controlling devices in Live from your MIDI 

controller(s).  It allows you to dedicate a MIDI controller (or multiple controllers if you like) to controlling a device or group 

of devices in Live.   

 

For example, you could set up all of the controls on a nanoKONTROL2 for controlling Operator parameters.  That sounds 

kind of like MIDI mapping, right?  The major difference though is that MIDI mapping in that way would only allow you to 

control a single instance of Operator and only in sets that contained the associated MIDI mapping.  With DDC, you could 

control the first instance of Operator on any track in any Live set!   

 

And that’s just the beginning.  You can also control multiple devices if you like.  So you could have some of the controls on a 

controller controlling Auto Filter, while others control EQ Eight and others control Beat Repeat.  You can also/alternatively 

control devices with specific names.  For example, instead of controlling any Audio Effect Rack, you could strictly control an 

Audio Effect Rack named “My Perfect Rack”. 

 

And you can have multiple pages of assignments if you like.  You could use each page to control a different aspect of an 

instrument like Analog.  Or each page could control a different device.  Whatever suits your workflow.  And, yes, all of this 

is fully compatible with Live’s Takeover functionality, so you’ll get no jumps in value when moving between 

tracks/devices/pages. 

 

And, finally, all of this is set up via an easy to use editor that edits MIDI Remote Scripts that you’ll use in Live.  Once you’re 

done editing, you’re good to go…no running external applications or M4L devices! 

 

NOTE:  This manual as well as information throughout DDC uses the term ‘encoder’ to mean an encoder, knob, fader or 

slider.  Essentially, an encoder is anything that isn’t a button or switch. 

 

2.1 What’s included? 
DDC consists of: 

- Six MIDI Remote Scripts named DDC_1 through DDC_6 (collectively referred to as DDC scripts).  This allows you 

to use up to six controllers for dedicated device control with each controlling different devices (or the same devices 

in different ways if you like). 

 

- The DDC Editor, which allows you to easily edit the settings of each of the DDC scripts.    

 

- The DDC_Capture_Tool, which is also a MIDI Remote Script.  This allows you to add 3rd party plugins and Max for 

Live devices to the list of devices that can be controlled from DDC scripts. 

 

- The DDC Repository, which is an online resource that contains files (such as controller-related files) for use with 

DDC scripts.  This repository can be found here:  http://goo.gl/6oixC5  
 

 

3 INSTALLING DDC 
The DDC Editor requires a Java runtime.  Before installing DDC, please ensure that you have a Java runtime installed and 

activated.  To verify this: 

 

WINDOWS: 

Go to http://java.com/en/download/installed.jsp 

 

OS X: 

Go to Applications/Utilities/Java Preferences or to System Preferences 

 

To install DDC, first close all other applications and then run the provided Setup executable (Windows) or *.dmg (OS X).  If 

you should run into trouble during install, please refer to the Troubleshooting section. 

 

In most cases, you will only need to install DDC once.  It will remain installed even after updating to a newer version of 

Live.  However, if you re-install Live or install Live to a new location, you will need to install DDC again.  It’s 

recommended that you keep the DDC Setup files on hand for such cases.   

http://goo.gl/6oixC5
http://java.com/en/download/installed.jsp
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4 SETTING UP YOUR CONTROLLER 
In order to use your controller(s) with DDC scripts, you will need to setup the controller(s).  The Controller Files folder on 

the DDC Repository (http://goo.gl/6oixC5) includes pre-configured presets/templates/scenes for a variety of controllers.   

 

If you can’t find a preset/template/scene for your controller in the repository or you need/want to set up a customized 

preset/template/scene for your controller, the following tables cover the MIDI messages you will need to assign to the 

controller. 

 

 

 By default, all of the controls listed in the tables below use MIDI channel 16.  This can be changed for each 

group/control in the editor. 

 

 By default, all of the buttons listed in the tables below use Notes.  This can be changed for each group/control in the 

editor. 

 

 The Note/CC numbers shown in the tables below should be suitable for most cases.  However, it is possible to 

define alternate Note/CC numbers (as well as define encoders to use Pitch Bend) via the Control Number Definitions 

file that is available from the Miscellaneous folder on the DDC Repository (http://goo.gl/6oixC5).  The folder also 

contains the Button Slider Definitions file, which allows you to define a group of 8 button sliders to use in place of 

Encoder Group D. 

 

 All buttons used in DDC are expected to be momentary meaning that they send an on message when pressed and an 

off message when released. 

 

 

4.1 Dedicated Device Control Groups 
This table covers the MIDI messages used for the dedicated device control groups.  The groups consist of 8 MIDI messages 

each.  However, this is primarily cosmetic as are the groups themselves.  In reality, DDC scripts allow you to use anywhere 

between 0 and 32 encoders and 0 and 32 buttons to control devices.  For example, if your controller only has 12 encoders, 

you’d use the 8 MIDI messages from Encoder Group A and the first 4 MIDI Messages from Group B (so CC 1 – 12). 
GROUP NAME MIDI MESSAGES 

Encoder Group A CC 1 – 8  

Encoder Group B CC 9 – 16  

Encoder Group C CC 17 – 24 

Encoder Group D CC 25 – 32  

  

Button Group A Note (or CC) 33 – 40  

Button Group B Note (or CC) 41 – 48 

Button Group C Note (or CC) 49 – 56 

Button Group D Note (or CC) 57 – 64  

 
 

4.2 Accessory Controls 
This table covers the MIDI messages used for non-essential, but useful controls that can be used in conjunction with the 

Dedicated Device Control Groups covered above. 
CONTROL/GROUP NAME MIDI MESSAGES NOTES 

Lock Button Note (or CC) 0 This button will lock to/unlock from the selected 

track.  This allows you to maintain control over a 

track while navigating around the set.  

Direct Page Buttons Note (or CC) 65 – 72 These buttons directly select pages. 

Prev Page Button Note (or CC) 73 Navigates to the previous page.  

Next Page Button Note (or CC) 74 Navigates to the next page. 

http://goo.gl/6oixC5
http://goo.gl/6oixC5
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5 LIVE SETTINGS 
The following settings will be found in Live’s Preferences 

on the MIDI/Sync tab.  The settings shown here are just 

examples of what your settings might look like.  The 

actual settings you will use depend on many factors such 

as the number of DDC scripts you’re using, which 

controller(s) you’re using and what exactly you’re using 

the controller(s) for.  This section will try to cover as many 

of these factors as possible. 

 

 

 

 

5.1 Control Surface Settings 

In the Control Surface section, you will select the DDC 

script(s) to use as well as the controller ports to use with 

each DDC script.  In our example here, DDC_1 is being 

used with the Akai MPK61 and DDC_2 is being used with 

the Novation Launch Control.  

 

Notice that, for DDC_1, we haven’t selected an Output.  The reason for this is that the Akai MPK61 doesn’t have LEDs that 

can be remotely controlled and so there is no reason to send an output to it.  On the other hand, the Novation Launch Control 

does have LEDs that can be remotely controlled and so we have selected an Output for DDC_2. 

 

Both of these controllers have knobs/faders that have a fixed range of movement and that send absolute values.   With 

controls of that type, it’s possible for a physical control to become out of sync with the parameter it’s controlling.  This can 

result in jumps in value when turning/moving a physical control.  To combat that, select a Takeover Mode other than None. 

 

5.2 MIDI Port Settings 

In the MIDI Ports section, you should turn off all of the Track/Sync/Remote switches for controllers you’re using with DDC 

scripts unless they are essential (when in doubt, leave it out!).  This is especially true in the case of Remote switches as 

discussed in the Other Settings section below.   

 

In our example here, we’ve turned on the Track switch for the Akai MPK61 so that we can use its keyboard and pads to play 

instruments. 

 

5.3 Other Settings 

It’s possible to use a controller with a DDC script while also using it for other purposes such as playing instruments and/or 

MIDI mapping.  You can also use other MIDI Remote Scripts with the controller.  However, when doing this, there are a few 

points to be aware of. 

 

- The controller cannot use the MIDI messages defined for DDC scripts for other purposes.  Attempting to do so will 

result in conflicts. 

 

- If you’re using the controller for MIDI mapping (and hence turning on its Remote switch(es)), then other controllers 

that are being used for MIDI mapping cannot use the MIDI messages defined for DDC scripts or conflicts will arise. 

 

- Live’s Takeover Mode functionality only works in cases where a physical control always sends the same MIDI 

message.  If you’re using a controller that needs takeover (to avoid jumps in value), you should not switch between 

the controller’s presets/templates/scenes when using it with Live or you may experience jumps in value when 

moving the controller’s physical controls.  FYI, DDC has no bearing on this, it’s just how Live’s Takeover 

functionality works. 
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6 THE DDC EDITOR 
The DDC Editor allows you to edit the settings of DDC scripts.  With this editor, you can primarily select which devices to 

control, make changes to assignments (in the Main Window described below) and adjust the settings of groups of controls.  

For the most part, each of the editing controls (buttons, menus, etc) in the editor has a tool tip, which will pop up when you 

hover your cursor over the control, to describe what the control does and thus makes using the editor much easier.  This 

section of the manual will cover the functionality of the editor in more detail. 

 

6.1 Selecting the DDC Script to Edit 
Upon launching the editor, you’ll be presented with a dialog that allows 

you to choose which DDC script to edit.   

 

 

NOTE:  You will not see this dialog the first time you run the editor.  

The first DDC script (DDC_1) will automatically be selected for editing. 

 

6.2 Main Window 
The main window of the editor primarily allows you to edit the assignment of each control used for dedicated device control.  

Up to 32 encoders and 32 buttons can be used for dedicated device control.   If your controller has fewer than 32 encoders (or 

buttons), you can leave the associated assignments blank as shown in GROUP D below. 

 

 
 

You can select which page to edit via the 8 radio buttons (1 – 8) in the PAGE section.  If you’d like to use more than one 

page, you will need to set up some controls on your controller for navigating between pages. 

 

The name of the selected page is shown in the PAGE NAME section.  This name will be displayed in Live’s status bar upon 

the page being selected.  The name of the page can be edited by clicking the Edit button in this section. 

 

The tabs near the top of the window (ENCODERS/BUTTONS) select which type of controls to edit; either encoders or 

buttons respectively.  The other sections of the window look the same regardless of which tab is selected. 
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Each control section displays the name of the device and parameter it’s assigned to (or ‘-‘ in the case of no assignment) for 

the selected page.  These assignments can be edited by clicking the associated Edit button, which will open the Encoder 

Editor or Button Editor, both of which are described below. 

 

Also, each group of 8 controls has a shared set of settings that can be edited by clicking the associated Edit Group Settings 

button, which will open the Control Group Settings Editor.   
 

6.2a Main Window Menus 
The menus at the top of the window (on Windows) or Mac menu bar (on OS X) provide access to the following functions. 

 

File: 
- Save and Transfer – Saves the current settings to file and transfers the settings to Live.   

- Import – Allows you to select files to import for use with the DDC script you’re editing. 

- Export – Allows you to easily export files for backup or for sharing on the repository. 

- Exit (Windows only) – Exits the application. 

 

Edit: 
- Edit Device List – Opens the Device List Editor. 

- Edit Accessory Controls – Opens the Accessory Controls Editor. 

- Copy to Page(s) – Displays a sub-menu that allows you to select the page(s) to copy the assignments of the selected 

page to. 

- Font Size - Sets the font size to use in the main window. 

 

Help: 
- About (Windows only) – Shows information about the application. 

- Open Manual – Opens this manual. 

- Create Troubleshooting Log – Creates a troubleshooting log to assist in troubleshooting problems with DDC. 

- Go to DDC Repository – Navigates to the online DDC Repository where you can download controller files and 

other DDC-related utilities. 
 

6.3 Encoder/Button Editors 
The Encoder and Button Editors allow you to edit the assignments of a single encoder or button. 

 

Device – Selects the device that this control should be assigned to.  The                    Encoder Editor 

devices available here are determined by the devices selected via the Device List 

Editor.  The menu also includes a None option which will cause the control to 

have no assignment. 

 

Parameter – Selects the parameter of the selected device that this control should 

be assigned to. 

 

Button Type (Buttons only) – Selects the type of control (Toggle or Momentary) 

the button will have over the selected parameter.  

          

Button LED Off/On Value (Buttons only) – Selects the LED values to use              Button Editor                                                      

when the parameter is off/on.  These are primarily only useful in the case of 

controllers that have buttons with multi-colored LEDs. 

 

In some cases, a button’s LED is controlled by multiple MIDI messages or by a 

different MIDI message than the button sends.  To work with LEDs like this, you 

can use the LED Output Transformer file that is available from the Miscellaneous 

folder on the DDC Repository (http://goo.gl/6oixC5). 

 

Assign – Stores the specified assignments. 

 

NOTE:  Only one encoder/button can be assigned to a parameter in a given 

page.  If you try to assign multiple encoders/buttons from the same page to the 

same parameter, you will receive an error message.  

http://goo.gl/6oixC5
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6.4 Control Group Settings Editor 
The Control Group Settings Editor allows you to edit the shared settings of a group of 8 controls. 

 

 

Type – In the case of encoders, this will select the type of MIDI values the          Editing Encoders 

encoders send.  If you’re not sure which type of MIDI values your encoders 

send, see the Determining Control Types section below. 

 

In the case of buttons, this will select the type of MIDI messages the buttons 

use.  If you’re not sure which type of MIDI messages your buttons use, see 

the Determining Control Types section below. 

 

Channel – Selects the MIDI channel the controls use.     Editing Buttons 

 

OK – Stores the specified settings. 

 

 

 

 

 
 

6.4a Determining Control Types 
If you’re not sure which type of MIDI values your encoders send or MIDI messages your buttons use, you can find this out 

by using MIDI Mapping in Live. 

 

First, in Live’s Preferences on the MIDI/Sync tab, you’ll need to turn on the Remote switch for your controller.  Next, you 

should open Live’s browser.  Then, enter MIDI mapping mode and map the control(s) in question to some parameter(s) in 

Live. 

 

In the case of encoders, the type of MIDI values the encoder 

uses will be shown in the bottom left hand side of Live’s 

window. 

 

In the case of buttons, the type of 

MIDI message will be shown in 

Live’s browser. 

 

 

 

 

 

6.5 Device List Editor 
The Device List Editor displays and allows you to edit the list of devices that will be available for assignment. 

 

 

Add Device – Opens the Add Device Dialog. 

 

Remove Device – Removes the selected device from the list.  Removing 

a device will cause any controls assigned to that device to have no 

assignment.   Removing all devices from this list is a quick way of 

removing the assignments of all controls so that you can start from a 

blank slate. 

 

 

NOTE:  DDC scripts will control the first instance of each of the specified devices found on the track.  This supports one 

level of nesting meaning that DDC scripts will look inside the top level chains of racks on the track to find the specified 

devices.   
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6.5a Add Device Dialog 
The Add Device Dialog allows you to select a device to add to the list of devices that will be available for assignment. 

 

 

Device Type – Selects the type of device to add.  By default, this 

will strictly list devices that are included with Live/Live Suite as 

well as the Mixer type, which provides access to the selected 

Track’s Mixer parameters.  You can add additional devices to 

this list as described in Controlling Non-Native Devices. 

 

Device Name (optional) – If this field is left blank, you'll be 

able to control the first instance of the Device Type on the 

selected Track regardless of what the Device Type's name is.  If 

you'd like to only control Device Types with a specific name, 

specify that name here.  This is primarily useful in the case of 

rack devices.  This field does not apply to Non-Native Devices or the Mixer type. 

 

Add – Adds the specified device to the list. 

 

 

NOTE:  This dialog will only allow a Device Type to be added once unless a Device Name is specified.  For example, it’s 

possible to add multiple Audio Effect Racks providing that each has a unique Device Name. 

 

6.6 Accessory Controls Editor 
The Accessory Controls Editor allows you to edit the settings of the Accessory Controls. 

 

 
Type – Selects the type of MIDI messages the button(s) use(s).  If you’re not sure which type of MIDI messages your 

button(s) use(s), see Determining Control Types. 

 

Channel – Selects the MIDI channel the button(s) use. 

          

Button LED Off/On Value – Selects the LED values to use for button off/on LED states.  These are primarily only useful in 

the case of controllers that have buttons with multi-colored LEDs. 

 

OK – Stores the specified settings. 
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7 ADVANCED SUBJECTS 
 

7.1 Controlling Non-Native Devices 
By default, the Device Type list in the Device List Editor will purely contain native Live devices.  However, it’s possible to 

amend the Device Type list to include 3rd party plugins and Max for Live devices of your choosing by using the following 

procedure: 

 

1. Close the DDC Editor. 

2. In Live’s Preferences on the MIDI/Sync tab, select DDC_Capture_Tool as a Control Surface.  Leave the Input and 

Output set to None. 

3. Load the device(s) you want to control onto a track (or multiple tracks if necessary) in Live. 

4. Select the first device you want to control and turn it off and then on again.  If the capture was successful, the status 

bar in Live will indicate that the device was captured. 

5. Repeat step #4 for other devices you want to control. 

6. Go back into Live’s Preferences and de-select DDC_Capture_Tool as a Control Surface. 

 

Re-launch the DDC Editor and you’ll find the new device(s) available in the Device List. 

 

NOTES:  It is recommended that you increase Live’s auto-population threshold for plugin parameters.  In many cases, this 

will negate the need to manually configure plugin parameters.   You can do this by creating an Options.txt file for Live (if you 

haven’t already) with the following setting: 

-_PluginAutoPopulateThreshold=-1 

 

The following article covers how to create an Options.txt file: 

https://www.ableton.com/en/articles/optionstxt-file-live/ 

 

 

If the device contains multiple parameters with the same name, each parameter with a duplicate name will show up in 

Parameter drop-down menus with ‘{Dupe—n}’ appended at the end of the parameter name where n will be the position of 

the parameter in the device’s parameter list. 

 

 

 
 

7.2 Max for Live Interface 
DDC scripts include a handy Max for Live interface that makes it extremely easy to access each script’s controls/groups of 

controls from Max for Live devices.  This allows you to create new (or retrofit existing) Max for Live devices to work 

directly with the controller(s) you’re using with DDC scripts.  An example of how to use this interface (named 

DDC_M4L_Example) can be found in the Max for Live Devices folder on the DDC Repository (http://goo.gl/6oixC5). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.ableton.com/en/articles/optionstxt-file-live/
http://goo.gl/6oixC5
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8 SHARING 
We’re hoping to make the DDC Repository (http://goo.gl/6oixC5) a very comprehensive resource that all users of DDC can 

benefit from and we could certainly use your help with that!  Please review the following information regarding preparing 

and submitting content for inclusion on the repository.   

 

In all cases, content submissions should be sent to support, should be in *.zip format and should contain a file named 

README that includes information and instructions on using/installing/transferring the content.   

 

Please do NOT submit any content that is copyrighted/licensed unless you are expressly permitted to do so by the copyright 

holder/license granter.   

 

 

CONTROLLER FILES: 
Unfortunately, controllers work in a variety of different ways and so there is no standard in terms of the files that are required 

to use controllers with DDC.  Essentially though, whichever files (whether they be controller-specific 

presets/templates/scenes or files such as alt_consts.py that you’ve downloaded from the repository) you need to create/edit in 

order to use the controller with DDC should be submitted.  The zip you create should have the same name as the controller 

(Akai APC40.zip for example).   

 

TIP:  You can select Export from the File menu in the DDC Editor to automate the above process. 

 

 

MAPPING FILES: 
All of the settings made for a DDC script via the DDC Editor are stored in a file named Mappings.py.  You can find this file 

in the script’s folder, which is located in the nativeKONTROL/DDC_Editor/(script_name) folder within your User directory.  

In many cases, a mappings file will only work correctly with a particular controller or a small group of controllers.  If the 

mappings only work with a particular controller, it’s probably best to submit the mappings as part of a Suite.  Otherwise, the 

zip you create should indicate the type of controllers the mappings can be used with.  If the mappings contain assignments to 

3rd party plugins or Max for Live devices, you should include the associated Device Files in your zip. 

 

 

DEVICE FILES: 
Device files (created via the DDC_Capture_Tool) can be found in the nativeKONTROL/DDC_Editor/Devices folder within 

your User directory.  Each device file is named according to the device it corresponds to.  The zip you create should have the 

same name as the device file. 

 

TIP:  You can select Export from the File menu in the DDC Editor to automate the above process. 

 

 

MAX FOR LIVE DEVICES: 
Max for Live devices you submit should be self-contained and not dependent on other files/libraries unless they are included 

with the device.  In most cases, you can self-contain a Max for Live device by freezing it.  Also, in most cases, the zip you 

create should have the same name as the Max for Live device. 

 

 

SUITES: 
Suites are essentially all the files one would need to use a particular controller with a particular mapping.  Suites, at the very 

least, should contain Controller Files and Mapping Files.  They may also contain Device Files and other content.  The zip you 

create should have the same name as the controller and include the word ‘Suite’ (Akai APC40 Suite.zip for example). 

 

 

 

 

 

 

 

http://goo.gl/6oixC5
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9 TROUBLESHOOTING 
This section provides resolutions to common problems that you may run into when installing or using DDC.  If you do not 

find a resolution to your problem here, please create a troubleshooting log via the Help menu in the DDC Editor and send it 

to Support along with a description of the problem. 

 

9.1 Windows Troubleshooting 
 

I’ve ran the provided Setup executable, but don’t find any DDC scripts listed under Control Surfaces. 

If Live was running at the time you ran the Setup executable, you will need to restart Live.  If this doesn’t resolve the 

problem, then it’s likely that you’ve installed Live in a protected location (such as Program Files).  In this case, you will need 

to elevate the permissions on your Live installation directory so that you can write to it.  Once this is done, re-run the Setup 

executable. 

 

9.2 OS X Troubleshooting 
 

I’ve ran the provided DDC Scripts Setup package, but don’t find DDC scripts listed under Control Surfaces. 

If Live was running at the time you ran the DDC Scripts Setup package, you will need to restart Live. 

 

When trying to run the DDC Scripts Setup package, I receive a message stating “DDC Scripts Setup can't be opened because 

it is from an unidentified developer”. 

Control-click or right click on the DDC Scripts Setup package and select Open from the menu that appears. 

 

Upon launching the DDC Editor, I receive a message stating “DDC Editor is damaged and can’t be opened.  You should 

move it to the Trash”. 

- Open Gatekeeper settings located in System Preferences > Security & Privacy. 

- Set Allow applications downloaded from to Anywhere and confirm by pressing Allow From Anywhere. 

- Launch the DDC Editor. 

- Restore your previous Gatekeeper setting, which is typically Mac App Store and identified developers. 
 

 

After performing certain actions in the DDC Editor, menus disappear from the Mac menu bar. 

You can work around this by using the Mac Menu Fix available from the Miscellaneous folder on the DDC Repository 

(http://goo.gl/6oixC5). 
 

 

9.3 General Troubleshooting 
 

After using Save and Transfer to transfer my settings to Live, the changes I made don’t seem to have effect. 

You need to load a new set/re-load the current set in Live in order for your changes to take effect. 

 

After using Save and Transfer to transfer my settings to Live and then loading a new set/re-loading the current set in Live, the 

changes I made don’t seem to have taken effect. 

By default, files will not be transferred to any Live installations that exist in non-default locations.  If you’d like files to be 

transferred to Live installations that exist in non-default locations, create a file named LiveDirs.txt in the 

nativeKONTROL/DDC_Editor folder within your User directory.  In this file, list the exact location of each Live installation 

that exists in a non-default location.  List each Live installation on a separate line.  To give you an example of what an exact 

location should look like: 

 

WINDOWS: 

C:\Program Files\My Custom Folder\Live 9 Suite 

 

OS X: 

/Applications/My Custom Folder/Ableton Live 9.app 

 

http://goo.gl/6oixC5
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10 SUPPORT 
 

Email: 
support@nativekontrol.com 

 

Forum: 
http://forum.nativekontrol.com 
 

 
 

 

 
 

 

 

 

Copyright 2015-2019 nativeKONTROL.  All rights reserved.  

 
This document, as well as the software described in it, is provided under license and may be used or copied only in accordance with 

the terms of this license.  The content of this document is furnished for informational use only, is subject to change without notice, 

and should not be construed as a commitment by nativeKONTROL.  Every effort has been made to ensure that the information in this 
document is accurate.  nativeKONTROL assumes no responsibility or liability for any errors or inaccuracies that may appear in this document. 

 

All product and company names mentioned in this document, as well as the software it describes, are trademarks or registered trademarks of their respective 
owners.  This software is solely endorsed and supported by nativeKONTROL.   

 

This software utilizes the macify library created by simplericity (http://simplericity.com/2007/10/02/1191336060000.html).  This is released under the 
Apache License version 2.0 (http://www.apache.org/licenses/LICENSE-2.0.html). 
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